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1 Introduction to Moderation SDK

Overview of Content Moderation
Content Moderation adopts image, text, audio, and video detection technologies
that detect pornography. This reduces potential business risks.

Content Moderation provides services through open application programming
interfaces (APIs). You can obtain the inference results by accessing and calling
APIs in real time. It helps you collect key data automatically and build an
intelligent service system, thereby improving service efficiency.

SDK Overview
Content Moderation Software Development Kit (Moderation SDK for short)
encapsulates the RESTful APIs provided by Content Moderation to simplify
application development. You can add dependencies or download SDKs to call
APIs to use Content Moderation.

Mappings Between Services and APIs
Table 1-1 lists the mappings between the Content Moderation sub-services and
APIs.

Table 1-1 Mappings between services and APIs

Service API

Text Moderation POST /v2/{project_id}/moderation/text

Image Moderation POST /v2/{project_id}/moderation/
image

Image Moderation (Batch) POST /v2/{project_id}/moderation/
image/batch

Image Moderation (Asynchronous
Batch) - Submitting a Task

POST /v2/{project_id}/moderation/
image/batch/jobs

Image Moderation (Asynchronous
Batch) - Querying the Result

GET /v2/{project_id}/moderation/
image/batch
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Service API

Image Moderation (Asynchronous
Batch) - Querying the Task List

GET /v2/{project_id}/moderation/
image/batch/jobs

Creating a Video Moderation Job POST /v3/{project_id}/moderation/
video/jobs

Querying a Video Moderation Job GET /v3/{project_id}/moderation/
video/jobs/{job_id}
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2 Applying for a Service

For details about how to apply for a service, see Applying for a Service in the
Content Moderation API Reference.

Content Moderation
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3 Obtaining Authentication Information

Step 1 Log in to the management console.

Step 2 Hover the cursor on the username and select My Credentials from the drop-down
list.

Step 3 Click the Access Keys tab and then click Add Access Key.

Step 4 Enter the verification code sent to your mail or mobile phone.

Step 5 Click OK to download the AK/SK of the authentication account. The AK/SK data is
saved in a local file. Keep the file secure.

----End

Content Moderation
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4 Preparing the Environment

Table 4-1 lists the environments you need to prepare when using Content
Moderation SDKs of different programming languages.

Table 4-1 Development environment

Progra
mming
Langua
ge

Item Description

Java Installing
JDK

An environment used for developing Java applications.
Java JDK 1.8 and later versions are supported. You are
advised to use the Java SDK by installing dependencies
through Apache Maven.

Python Installing
Python

Python 3.3 and later versions are supported.

.NET Installing .N
ET

.NET Standard 2.0 and later versions, and C# 4.0 and
later versions are supported.

Go Installing
GO

Go 1.14 and later versions are supported.

PHP Installing
PHP

The php.7.x version is recommended.

Node.js Installing
Node.js

The Node.js 8.x version is supported.

Content Moderation
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5 Using the SDK (Java)

5.1 Preparing a Java Development Environment
Moderation Java SDK uses Java SE Development Kit 8 (JDK 8) or later. The
following uses JDK 8 (Windows x64) running on Windows 7 as an example. If you
have downloaded the JDK and configured the environment, skip this section.

Step 1 Download the JDK file.

Step 2 After the JDK file is downloaded, install the JDK as prompted. For example, install
the JDK to the C:\Program Files\Java\jdk1.8.0_131 directory on the local PC.

Step 3 Right-click Computer, choose Properties > Advanced System Settings >
Environment Variables, and perform the following operations to configure Java
environment variables:

1. Create system variable JAVA_HOME whose value is the JDK installation path.
2. Add %JAVA_HOME%\bin;%JAVA_HOME%\jre\bin to Path. Separate

multiple values with semicolons (;).
3. Create system variable CLASSPATH whose value is %JAVA_HOME%\lib

\dt.jar;%JAVA_HOME%\lib\tools.jar.

Step 4 Open the command line interface (CLI) and run java -version. If the information
shown in Figure 5-1 is displayed, the configuration is successful.

Figure 5-1 Java version information

----End
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5.2 Obtaining and Installing the Java SDK
You are advised to use the Java SDK for Content Moderation by installing
dependencies through Apache Maven.

Step 1 Download and install Apache Maven on your operating system.

Step 2 After installing and configuring Maven, run the mvn -v command. Maven is
installed successfully if the following information is displayed.

Step 3 Add dependencies to an existing Maven project or use an integrated development
environment (IDE) to create a Maven project.

To create a Maven project using IntelliJ IDEA (an example IDE), perform the
following steps (skip if you already have a Maven project):

1. Start IntelliJ IDEA.
2. Choose File > New > project...
3. In the displayed New Project dialog box, click Maven and then Next.
4. Specify GroupId and ArtifactId, and click Next.
5. Specify Project name and Project location, and click Finish.

Step 4 Add dependency items to the pom.xml file of the Maven project.

The following is the dependency for Content Moderation SDK 3.0.55:
<dependency>
    <groupId>com.huaweicloud.sdk</groupId>
    <artifactId>huaweicloud-sdk-moderation</artifactId>
    <version>3.0.55</version>
</dependency>

The following sample code uses the fastjson dependency (ignore and delete it if it
is not required):

<dependency>
    <groupId>com.alibaba</groupId>
    <artifactId>fastjson</artifactId>
    <version>1.2.70</version>
</dependency>

----End

5.3 SDK Calling Example

5.3.1 Moderation (Text)

Content Moderation
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5.3.1.1 Text Moderation (V2)
1. This section describes how to use the Text Moderation SDK by AK/SK

authentication.
Replace the AK/SK in the sample code with the actual AK/SK. You can use the
withText method of the TextDetectionItemsReq class to configure the text
to be detected, and execute the code.
package com.huaweicloud.sdk.test;

import com.alibaba.fastjson.JSON;

import com.huaweicloud.sdk.core.auth.ICredential;
import com.huaweicloud.sdk.core.auth.BasicCredentials;
import com.huaweicloud.sdk.core.exception.ConnectionException;
import com.huaweicloud.sdk.core.exception.RequestTimeoutException;
import com.huaweicloud.sdk.core.exception.ServiceResponseException;
import com.huaweicloud.sdk.moderation.v2.ModerationClient;
import com.huaweicloud.sdk.moderation.v2.region.ModerationRegion;
import com.huaweicloud.sdk.moderation.v2.model.RunTextModerationResponse;
import com.huaweicloud.sdk.moderation.v2.model.TextDetectionReq;
import com.huaweicloud.sdk.moderation.v2.model.RunTextModerationRequest;
import com.huaweicloud.sdk.moderation.v2.model.TextDetectionItemsReq;

import java.util.List;
import java.util.ArrayList;

public class RunTextModerationSolution {

    public static void main(String[] args) {
       //Enter your AK/SK.
        String ak = "<YOUR AK>";
        String sk = "<YOUR SK>";

        ICredential auth = new BasicCredentials()
                .withAk(ak)
                .withSk(sk);

        ModerationClient client = ModerationClient.newBuilder()
                .withCredential(auth)
                .withRegion(ModerationRegion.valueOf("xxx"))  //Replace xxx with the region where the 
service is located, for example, cn-north-4.
                .build();
        RunTextModerationRequest request = new RunTextModerationRequest();
        TextDetectionReq body = new TextDetectionReq();
        List<TextDetectionItemsReq> listbodyItems = new ArrayList<>();
        listbodyItems.add(
            new TextDetectionItemsReq()
                .withText("text")    //Enter the text to be detected.
                .withType("content")
        );
        List<String> listbodyCategories = new ArrayList<>();
        listbodyCategories.add("abuse");
        listbodyCategories.add("porn");
        listbodyCategories.add("contraband");
        listbodyCategories.add("flood");
        body.withItems(listbodyItems);
        body.withCategories(listbodyCategories);
        request.withBody(body);
        try {
            RunTextModerationResponse response = client.runTextModeration(request);
            System.out.println(response.getHttpStatusCode());
            System.out.println(JSON.toJSON(response));
        } catch (ConnectionException e) {
            e.printStackTrace();
        } catch (RequestTimeoutException e) {
            e.printStackTrace();
        } catch (ServiceResponseException e) {
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            e.printStackTrace();
            System.out.println(e.getHttpStatusCode());
            System.out.println(e.getErrorCode());
            System.out.println(e.getErrorMsg());
        }
    }
}

2. If 200 is displayed on the console, the code is successfully executed. The text
moderation result is displayed on the console.
200
{"result":{"suggestion":"block","detail":{"contraband":["potassium arsenite"],"porn":["nude 
chat"]}},"httpStatusCode":200}

5.3.2 Moderation (Image)

5.3.2.1 Image Moderation (V2)
1. This section describes how to use the Image Moderation SDK by AK/SK

authentication.
Replace the AK/SK in the sample code with the actual AK/SK. You can use the
withUrl or withImage method of the ImageDetectionReq class to configure
image information (either the image or url parameter). This section uses url
as an example.
package com.huaweicloud.sdk.test;

import com.alibaba.fastjson.JSON;

import com.huaweicloud.sdk.core.auth.ICredential;
import com.huaweicloud.sdk.core.auth.BasicCredentials;
import com.huaweicloud.sdk.core.exception.ConnectionException;
import com.huaweicloud.sdk.core.exception.RequestTimeoutException;
import com.huaweicloud.sdk.core.exception.ServiceResponseException;
import com.huaweicloud.sdk.moderation.v2.ModerationClient;
import com.huaweicloud.sdk.moderation.v2.region.ModerationRegion;
import com.huaweicloud.sdk.moderation.v2.model.RunImageModerationRequest;
import com.huaweicloud.sdk.moderation.v2.model.ImageDetectionReq;
import com.huaweicloud.sdk.moderation.v2.model.RunImageModerationResponse;

import java.util.List;
import java.util.ArrayList;

public class RunImageModerationSolution {
    public static void main(String[] args) {
       //Enter your AK/SK.
        String ak = "<YOUR AK>";
        String sk = "<YOUR SK>";
        ICredential auth = new BasicCredentials()
            .withAk(ak)
            .withSk(sk);
        ModerationClient client = ModerationClient.newBuilder()
            .withCredential(auth)
            .withRegion(ModerationRegion.valueOf("xxx"))  //Replace xxx with the region where the 
service is located.
            .build();
        RunImageModerationRequest request = new RunImageModerationRequest();
        ImageDetectionReq body = new ImageDetectionReq();
        List<ImageDetectionReq.CategoriesEnum> listbodyCategories = new ArrayList<>();
        listbodyCategories.add(ImageDetectionReq.CategoriesEnum.fromValue("porn"));
        body.withCategories(listbodyCategories);
        body.withModerationRule("default");
        body.withUrl("https://XXX.jpg");  //Replace it with an image URL that can be accessed from the 
Internet.
        request.withBody(body);
        try {
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            RunImageModerationResponse response = client.runImageModeration(request);
            System.out.println(response.getHttpStatusCode());
            System.out.println(JSON.toJSONString(response));
        } catch (ConnectionException e) {
            e.printStackTrace();
        } catch (RequestTimeoutException e) {
            e.printStackTrace();
        } catch (ServiceResponseException e) {
            e.printStackTrace();
            System.out.println(e.getHttpStatusCode());
            System.out.println(e.getErrorCode());
            System.out.println(e.getErrorMsg());
        }
    }
}

2. If 200 is displayed on the console, the code is successfully executed. The
Image Moderation result is displayed on the console.
200
{"httpStatusCode":200,"result":{"categorySuggestions":{"porn":"pass"},"detail":{"porn":[{"confidence":
0.9883,"label":"normal"},{"confidence":0.0039,"label":"porn"},{"confidence":
0.0078,"label":"sexy"}],"{"confidence":2.0E-4,"label":"fascist"},{"confidence":1.0E-4,"label":"cult"},
{"confidence":2.0E-4,},{"confidence":1.0E-4},{"confidence":1.0E-4,"label":"kidnap"},{"confidence":
6.0E-4,"label":"riot"},{"confidence":1.0E-4,"label":"parade"},{"confidence":2.0E-4,"label":"corpse"},
{"confidence":1.0E-4,"label":"bloody"},{"confidence":1.0E-4,"label":"knife"},{"confidence":
1.0E-4,"label":"gun"},{"confidence":2.0E-4,"label":"military_weapon"},{"confidence":
0.0,"label":"special_characters"},{"confidence":0.9994,"label":"normal"}]},"suggestion":"pass"}}

Process finished with exit code 0

5.3.2.2 Image Moderation (Batch) (V2)
1. This section describes how to use the Image Moderation SDK by AK/SK

authentication.
Replace the AK/SK in the sample code with the actual AK/SK. You can use the
withUrls method of the ImageBatchModerationReq class to configure the
URLs of the images to be reviewed, and then execute the code.

package com.huaweicloud.sdk.test;

import com.alibaba.fastjson.JSON;

import com.huaweicloud.sdk.core.auth.ICredential;
import com.huaweicloud.sdk.core.auth.BasicCredentials;
import com.huaweicloud.sdk.core.exception.ConnectionException;
import com.huaweicloud.sdk.core.exception.RequestTimeoutException;
import com.huaweicloud.sdk.core.exception.ServiceResponseException;
import com.huaweicloud.sdk.moderation.v2.ModerationClient;
import com.huaweicloud.sdk.moderation.v2.region.ModerationRegion;
import com.huaweicloud.sdk.moderation.v2.model.RunImageBatchModerationRequest;
import com.huaweicloud.sdk.moderation.v2.model.ImageBatchModerationReq;
import com.huaweicloud.sdk.moderation.v2.model.RunImageBatchModerationResponse;

import java.util.List;
import java.util.ArrayList;

public class RunImageBatchModerationSolution {
    public static void main(String[] args) {
       //Enter your AK/SK.
        String ak = "<YOUR AK>";
        String sk = "<YOUR SK>";
        ICredential auth = new BasicCredentials()
            .withAk(ak)
            .withSk(sk);
        ModerationClient client = ModerationClient.newBuilder()
            .withCredential(auth)
            .withRegion(ModerationRegion.valueOf("xxx")) //Replace xxx with the region where the 
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service is located.
            .build();
        RunImageBatchModerationRequest request = new RunImageBatchModerationRequest();
        ImageBatchModerationReq body = new ImageBatchModerationReq();
        List<ImageBatchModerationReq.CategoriesEnum> listbodyCategories = new ArrayList<>();
        listbodyCategories.add(ImageBatchModerationReq.CategoriesEnum.fromValue("porn"));
        List<String> listbodyUrls = new ArrayList<>();
        listbodyUrls.add("https://XXX.jpg");//Replace it with an image URL that can be accessed from 
the Internet.
        body.withThreshold((double) 0);
        body.withCategories(listbodyCategories);
        body.withUrls(listbodyUrls);
        request.withBody(body);
        try {
            RunImageBatchModerationResponse response = client.runImageBatchModeration(request);
            System.out.println(response.getHttpStatusCode());
            System.out.println(JSON.toJSONString(response));
        } catch (ConnectionException e) {
            e.printStackTrace();
        } catch (RequestTimeoutException e) {
            e.printStackTrace();
        } catch (ServiceResponseException e) {
            e.printStackTrace();
            System.out.println(e.getHttpStatusCode());
            System.out.println(e.getErrorCode());
            System.out.println(e.getErrorMsg());
        }
    }
}

2. If 200 is displayed on the console, the code is successfully executed. The batch
Image Moderation result is displayed on the console.
200
{"httpStatusCode":200,"result":[{"categorySuggestions":{"porn":"pass"},"detail":{"porn":[{"confidence":
0.9883,"label":"normal"},{"confidence":0.0039,"label":"porn"},{"confidence":0.0078,"label":"sexy"}],
{"confidence":2.0E-4,"label":"fascist"},{"confidence":1.0E-4,"label":"cult"},{"confidence":2.0E-4},
{"confidence":1.0E-4,"label":"kidnap"},{"confidence":6.0E-4,"label":"riot"},{"confidence":
1.0E-4,"label":"parade"},{"confidence":2.0E-4,"label":"corpse"},{"confidence":1.0E-4,"label":"bloody"},
{"confidence":1.0E-4,"label":"knife"},{"confidence":1.0E-4,"label":"gun"},{"confidence":
2.0E-4,"label":"military_weapon"},{"confidence":0.0,"label":"special_characters"},{"confidence":
0.9994,"label":"normal"}]},"suggestion":"pass","url":"https://sdk-obs-source-save.obs.cn-
north-4.myhuaweicloud.com/terrorism.jpg"}]}

5.3.2.3 Image Moderation (Asynchronous Batch) (V2)

5.3.2.3.1 Submitting a Task

1. This section describes how to use the Image Moderation SDK by AK/SK
authentication.
Replace the AK/SK in the sample code with the actual AK/SK. You can use the
withUrls method of the RunTaskSumbitRequest class to configure the URLs
of the images to be reviewed, and then execute the code.

package com.huaweicloud.sdk.test;

import com.alibaba.fastjson.JSON;

import com.huaweicloud.sdk.core.auth.ICredential;
import com.huaweicloud.sdk.core.auth.BasicCredentials;
import com.huaweicloud.sdk.core.exception.ConnectionException;
import com.huaweicloud.sdk.core.exception.RequestTimeoutException;
import com.huaweicloud.sdk.core.exception.ServiceResponseException;
import com.huaweicloud.sdk.moderation.v2.ModerationClient;
import com.huaweicloud.sdk.moderation.v2.region.ModerationRegion;
import com.huaweicloud.sdk.moderation.v2.model.RunTaskSumbitRequest;
import com.huaweicloud.sdk.moderation.v2.model.TaskSumbitReq;
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import com.huaweicloud.sdk.moderation.v2.model.RunTaskSumbitResponse;

import java.util.List;
import java.util.ArrayList;

public class RunTaskSumbitSolution {
    public static void main(String[] args) {
       //Enter your AK/SK.
        String ak = "<YOUR AK>";
        String sk = "<YOUR SK>";
        ICredential auth = new BasicCredentials()
            .withAk(ak)
            .withSk(sk);
        ModerationClient client = ModerationClient.newBuilder()
            .withCredential(auth)
            .withRegion(ModerationRegion.valueOf("xxx"))   //Replace xxx with the region where the 
service is located.
            .build();
        RunTaskSumbitRequest request = new RunTaskSumbitRequest();
        TaskSumbitReq body = new TaskSumbitReq();
        List<TaskSumbitReq.CategoriesEnum> listbodyCategories = new ArrayList<>();
        listbodyCategories.add(TaskSumbitReq.CategoriesEnum.fromValue("porn"));
        List<String> listbodyUrls = new ArrayList<>();
        listbodyUrls.add("https://XXX.jpg"); //Replace it with an image URL that can be accessed from 
the Internet.
        body.withCategories(listbodyCategories);
        body.withUrls(listbodyUrls);
        request.withBody(body);
        try {
            RunTaskSumbitResponse response = client.runTaskSumbit(request);
            System.out.println(response.getHttpStatusCode());
            System.out.println(JSON.toJSONString(response));
        } catch (ConnectionException e) {
            e.printStackTrace();
        } catch (RequestTimeoutException e) {
            e.printStackTrace();
        } catch (ServiceResponseException e) {
            e.printStackTrace();
            System.out.println(e.getHttpStatusCode());
            System.out.println(e.getErrorCode());
            System.out.println(e.getErrorMsg());
        }
    }
}

2. If 200 is displayed on the console, the code is successfully executed. The result
of submitting the Image Moderation (Asynchronous Batch) task is displayed
on the console.
200
{"httpStatusCode":200,"result":{"jobId":"7f6a5881-7774-40cf-903b-4548914b55a3"}}

Process finished with exit code 0

5.3.2.3.2 Querying a Task

1. This section describes how to use the Image Moderation (Asynchronous
Batch) SDK for querying a task by AK/SK authentication.
Replace the AK/SK in the sample code with the actual AK/SK. Use the
withJobId method of the RunCheckResultRequest class to configure the ID
of the moderation task, and then execute the code.

package com.huaweicloud.sdk.test;

import com.alibaba.fastjson.JSON;

import com.huaweicloud.sdk.core.auth.ICredential;
import com.huaweicloud.sdk.core.auth.BasicCredentials;
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import com.huaweicloud.sdk.core.exception.ConnectionException;
import com.huaweicloud.sdk.core.exception.RequestTimeoutException;
import com.huaweicloud.sdk.core.exception.ServiceResponseException;
import com.huaweicloud.sdk.moderation.v2.ModerationClient;
import com.huaweicloud.sdk.moderation.v2.region.ModerationRegion;
import com.huaweicloud.sdk.moderation.v2.model.RunCheckResultRequest;
import com.huaweicloud.sdk.moderation.v2.model.RunCheckResultResponse;

public class RunCheckResultSolution {

    public static void main(String[] args) {
       //Enter your AK/SK.
        String ak = "<YOUR AK>";
        String sk = "<YOUR SK>";

        ICredential auth = new BasicCredentials()
                .withAk(ak)
                .withSk(sk);

        ModerationClient client = ModerationClient.newBuilder()
                .withCredential(auth)
                .withRegion(ModerationRegion.valueOf("xxx"))  //Replace xxx with the region where the 
service is located.
                .build();
        RunCheckResultRequest request = new RunCheckResultRequest();
        request.withJobId("7f6a5881-7774-40cf-903b-4548914b55a3");
        try {
            RunCheckResultResponse response = client.runCheckResult(request);
            System.out.println(response.getHttpStatusCode());
            System.out.println(JSON.toJSONString(response));
        } catch (ConnectionException e) {
            e.printStackTrace();
        } catch (RequestTimeoutException e) {
            e.printStackTrace();
        } catch (ServiceResponseException e) {
            e.printStackTrace();
            System.out.println(e.getHttpStatusCode());
            System.out.println(e.getErrorCode());
            System.out.println(e.getErrorMsg());
        }
    }
}

1. If 200 is displayed on the console, the code is successfully executed. The result
of querying the Image Moderation (Asynchronous Batch) task is displayed on
the console.
200
{"httpStatusCode":200,"result":{"createTime":"2021-08-13T03:46:30Z","items":[{"categorySuggestions":
{
"porn":"pass"},"detail":{"porn":[{"confidence":0.9883,"label":"normal"},{"confidence":
0.0039,"label":"porn"},{"confidence":0.0078,"label":"sexy"}],"terrorism":[{"confidence":
2.0E-4,"label":"terrorist"},{"confidence":2.0E-4,"label":"fascist"},{"confidence":1.0E-4,"label":"cult"},
{"confidence":2.0E-4},{"confidence":1.0E-4},{"confidence":1.0E-4,"label":"kidnap"},{"confidence":
6.0E-4,"label":"riot"},{"confidence":1.0E-4,"label":"parade"},{"confidence":2.0E-4,"label":"corpse"},
{"confidence":1.0E-4,"label":"bloody"},{"confidence":1.0E-4,"label":"knife"},{"confidence":
1.0E-4,"label":"gun"},{"confidence":2.0E-4,"label":"military_weapon"},{"confidence":
0.0,"label":"special_characters"},{"confidence":
0.9994,"label":"normal"}]},"suggestion":"pass","url":"https://sdk-obs-source-save.obs.cn-
north-4.myhuaweicloud.com/
terrorism.jpg"}],"jobId":"7f6a5881-7774-40cf-903b-4548914b55a3","status":"finish","updateTime":"202
1-08-13T03:46:30Z"}}

Process finished with exit code 0

5.3.3 Moderation (Video)
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5.3.3.1 Creating a Video Moderation Job
1. This section describes how to create a video moderation job using the video

moderation SDK and AK/SK.

Replace the AK/SK in the sample code with the actual AK/SK. You can use the
withUrls method of the RunCreateVideoModerationJobRequest class to
configure the URLs of the videos to be reviewed, and then execute the code.

package com.huaweicloud.sdk.test;
 
import com.huaweicloud.sdk.core.auth.ICredential;
import com.huaweicloud.sdk.core.auth.BasicCredentials;
import com.huaweicloud.sdk.core.exception.ConnectionException;
import com.huaweicloud.sdk.core.exception.RequestTimeoutException;
import com.huaweicloud.sdk.core.exception.ServiceResponseException;
import com.huaweicloud.sdk.moderation.v3.region.ModerationRegion;
import com.huaweicloud.sdk.moderation.v3.*;
import com.huaweicloud.sdk.moderation.v3.model.*;
 
import java.util.List;
import java.util.ArrayList;
 
public class RunCreateVideoModerationJobSolution {
 
    public static void main(String[] args) {
       //Enter your AK/SK.
        String ak = "<YOUR AK>";
        String sk = "<YOUR SK>";
 
        ICredential auth = new BasicCredentials()
                .withAk(ak)
                .withSk(sk);
 
        ModerationClient client = ModerationClient.newBuilder()
                .withCredential(auth)
                .withRegion(ModerationRegion.valueOf("xxx"))  //Replace xxx with the region where the 
service is located.
                .build();
        RunCreateVideoModerationJobRequest request = new RunCreateVideoModerationJobRequest();
        VideoCreateRequest body = new VideoCreateRequest();
        List<VideoCreateRequest.AudioCategoriesEnum> listbodyAudioCategories = new ArrayList<>();
        listbodyAudioCategories.add(VideoCreateRequest.AudioCategoriesEnum.fromValue("porn"));
        List<VideoCreateRequest.ImageCategoriesEnum> listbodyImageCategories = new ArrayList<>();
        listbodyImageCategories.add(VideoCreateRequest.ImageCategoriesEnum.fromValue("porn"));
        VideoCreateRequestData databody = new VideoCreateRequestData();
        databody.withUrl("http://xxx.xx.xxxx")
            .withFrameInterval(5.5f);
        body.withCallback("http://xxx.xx.xxxx");
        body.withAudioCategories(listbodyAudioCategories);
        body.withImageCategories(listbodyImageCategories);
        body.withEventType(VideoCreateRequest.EventTypeEnum.fromValue("default"));
        body.withData(databody);
        request.withBody(body);
        try {
            RunCreateVideoModerationJobResponse response = 
client.runCreateVideoModerationJob(request);
            System.out.println(response.toString());
        } catch (ConnectionException e) {
            e.printStackTrace();
        } catch (RequestTimeoutException e) {
            e.printStackTrace();
        } catch (ServiceResponseException e) {
            e.printStackTrace();
            System.out.println(e.getHttpStatusCode());
            System.out.println(e.getErrorCode());
            System.out.println(e.getErrorMsg());
        }
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    }
}

2. The console returns the creation result of the video moderation job.
class RunCreateVideoModerationJobResponse {
    requestId: 5e353de1badd90049a2ac3d2e3ee925e
    jobId: 01663171200_48ce5a21498e47af8f2a49773c3d0fce
}

5.3.3.2 Querying a Video Moderation Job
1. This section describes how to query a video moderation job using the video

moderation SDK and AK/SK.
Replace the AK/SK in the sample code with the actual AK/SK. Use the
withJobId method of the RunQueryVideoModerationJobRequest class to
configure the ID of the moderation task, and then execute the code.

package com.huaweicloud.sdk.test;
 
import com.huaweicloud.sdk.core.auth.ICredential;
import com.huaweicloud.sdk.core.auth.BasicCredentials;
import com.huaweicloud.sdk.core.exception.ConnectionException;
import com.huaweicloud.sdk.core.exception.RequestTimeoutException;
import com.huaweicloud.sdk.core.exception.ServiceResponseException;
import com.huaweicloud.sdk.moderation.v3.region.ModerationRegion;
import com.huaweicloud.sdk.moderation.v3.*;
import com.huaweicloud.sdk.moderation.v3.model.*;
 
public class RunQueryVideoModerationJobSolution {
 
    public static void main(String[] args) {
       //Enter your AK/SK.
        String ak = "<YOUR AK>";
        String sk = "<YOUR SK>";
 
        ICredential auth = new BasicCredentials()
                .withAk(ak)
                .withSk(sk);
 
        ModerationClient client = ModerationClient.newBuilder()
                .withCredential(auth)
                .withRegion(ModerationRegion.valueOf("xxx"))  //Replace xxx with the region where the 
service is located.
                .build();
        RunQueryVideoModerationJobRequest request = new RunQueryVideoModerationJobRequest();
        request.withJobId("jobId");
        try {
            RunQueryVideoModerationJobResponse response = 
client.runQueryVideoModerationJob(request);
            System.out.println(response.toString());
        } catch (ConnectionException e) {
            e.printStackTrace();
        } catch (RequestTimeoutException e) {
            e.printStackTrace();
        } catch (ServiceResponseException e) {
            e.printStackTrace();
            System.out.println(e.getHttpStatusCode());
            System.out.println(e.getErrorCode());
            System.out.println(e.getErrorMsg());
        }
    }
}

2. The console returns the query result of the video moderation job.
class RunQueryVideoModerationJobResponse {
    requestId: a6dcb5c9f993efb977c8898e1ef91c87
    jobId: 01663171200_48ce5a21498e47af8f2a49773c3d0fce
    status: running
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    requestParams: class VideoModerationResultRequestParams {
        data: class VideoModerationResultRequestParamsData {
            url: http://xxx.xx.xxxx
            frameInterval: 5
        }
        eventType: default
        imageCategories: [porn, image_text, terrorism]
        audioCategories: [ad, porn]
        callback: http://xxx.xx.xxxx
    }
    createTime: null
    updateTime: 2022-09-15T14:08:06.006Z
    result: null
}
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6 Using the Python SDK

6.1 Preparing a Python Development Environment
To use the Python SDK of Content Moderation, you need to configure the Python
development environment.

1. Download Python of a proper version from Python official website and
install it. Python3.3 or later is recommended. This section uses Python 3.7 as
an example.

2. Download the latest version of PyCharm from PyCharm's official website.
3. Start the PyCharm development tool and choose File > Settings > Project

Interpreter to configure the Python environment.
4. Select the Python installation path. See Figure 6-1. After selecting the target

Python, click Apply at the bottom of the page to complete the configuration.
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Figure 6-1 Configuring the python environment using PyCharm

6.2 Obtaining and Installing the Python SDK
To obtain and install the Python SDK, you are advised to use pip commands or
PyCharm. You need to install the huaweicloudsdkcore and
huaweicloudsdkmoderation packages as follows:

Install the Python SDK using pip commands:
# Install the huaweicloudsdkcore package.
pip install huaweicloudsdkcore

# Install the huaweicloudsdkmoderation package.
pip install huaweicloudsdkmoderation

To install the Python SDK using PyCharm, perform the following steps:

1. Start PyCharm and choose File > Settings...
2. Choose Python Interpreter.
3. Click +, search for huaweicloudsdkcore and huaweicloudsdkmoderation,

and click Install Package in the lower left corner to install the packages.
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Figure 6-2 Installing the Python SDK for Content Moderation using PyCharm

6.3 SDK Calling Example

6.3.1 Moderation (Text)

6.3.1.1 Text Moderation (V2)
1. This section describes how to use the Text Moderation SDK by AK/SK

authentication.
Replace the AK/SK in the sample code with the actual AK/SK. Set the value of
text in TextDetectionItemsReq in the code to configure the text to be
detected, and execute the code.
# coding: utf-8

from huaweicloudsdkcore.auth.credentials import BasicCredentials
from huaweicloudsdkcore.exceptions import exceptions
from huaweicloudsdkmoderation.v2.region.moderation_region import ModerationRegion
from huaweicloudsdkmoderation.v2 import 
ModerationClient,RunTextModerationRequest,TextDetectionItemsReq,TextDetectionReq

if __name__ == "__main__":
       //Enter your AK/SK.
    ak = "<YOUR AK>"
    sk = "<YOUR SK>"

    credentials = BasicCredentials(ak, sk)

    client = ModerationClient.new_builder() \
        .with_credentials(credentials) \
        .with_region(ModerationRegion.value_of("xxx")) \   //Replace xxx with the region where the 
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service is located.
        .build()

    try:
        request = RunTextModerationRequest()
        listTextDetectionItemsReqItemsbody = [
            TextDetectionItemsReq(
                text="text",  //Enter the text to be detected.
                type="content"
            )
        ]
        listTextDetectionReqCategoriesbody = [
            "porn",
            "abuse",
            "contraband",
            "flood"
        ]
        request.body = TextDetectionReq(
            items=listTextDetectionItemsReqItemsbody,
            categories=listTextDetectionReqCategoriesbody
        )
        response = client.run_text_moderation(request)
        print(response.status_code)
        print(response)
    except exceptions.ClientRequestException as e:
        print(e.status_code)
        print(e.request_id)
        print(e.error_code)
        print(e.error_msg)

2. If 200 is displayed on the console, the code is successfully executed. The text
moderation result is displayed on the console.
200
{"result": {"suggestion": "block", "detail": {"contraband": ["potassium arsenite"], "porn": ["nude 
chat"]}}}}

6.3.2 Moderation (Image)

6.3.2.1 Image Moderation (V2)
1. This section describes how to use the Image Moderation SDK by AK/SK

authentication.
Replace the AK/SK in the sample code with the actual AK/SK. You can modify
either the image or url parameter in ImageDetectionReq to configure image
information. This section uses url as an example.

# coding: utf-8

from huaweicloudsdkcore.auth.credentials import BasicCredentials
from huaweicloudsdkcore.exceptions import exceptions
from huaweicloudsdkmoderation.v2.region.moderation_region import ModerationRegion
from huaweicloudsdkmoderation.v2 import 
ModerationClient,RunImageModerationRequest,ImageDetectionReq

if __name__ == "__main__":
       //Enter your AK/SK.
    ak = "<YOUR AK>"
    sk = "<YOUR SK>"

    credentials = BasicCredentials(ak, sk)

    client = ModerationClient.new_builder() \
        .with_credentials(credentials) \
        .with_region(ModerationRegion.value_of("xxx")) \   //Replace xxx with the region where the 
service is located.

Content Moderation
SDK Reference 6 Using the Python SDK

Issue 01 (2023-08-22) Copyright © Huawei Technologies Co., Ltd. 20

https://support.huaweicloud.com/intl/en-us/api-moderation/moderation_03_0018.html#section5
https://support.huaweicloud.com/intl/en-us/api-moderation/moderation_03_0018.html#section5


        .build()

    try:
        request = RunImageModerationRequest()
        listImageDetectionReqCategoriesbody = [
            "porn",
        ]
        request.body = ImageDetectionReq(
            threshold=0,
            categories=listImageDetectionReqCategoriesbody,
            moderation_rule="default",
            url="https://XXX.jpg"  //Replace it with an image URL that can be accessed from the Internet.
        )
        response = client.run_image_moderation(request)
        print(response.status_code)
        print(response)
    except exceptions.ClientRequestException as e:
        print(e.status_code)
        print(e.request_id)
        print(e.error_code)
        print(e.error_msg)

2. If 200 is displayed on the console, the code is successfully executed. The
image moderation result is displayed on the console.
200
{"result": {"detail": { "porn": [{"confidence": 0.9883, "label": "normal"}, {"confidence": 0.0039, "label": 
"porn"}, {"confidence": 0.0078, "label": "sexy"}]}, "suggestion": "pass", "category_suggestions": 
{   "porn": "pass"}}}
Process finished with exit code 0

6.3.2.2 Image Moderation (Batch) (V2)
1. This section describes how to use the Image Moderation SDK by AK/SK

authentication.
Replace the AK/SK in the sample code with the actual AK/SK. You can set Urls
in ImageBatchModerationReq to configure the URLs of the images to be
reviewed, and then execute the code.

# coding: utf-8

from huaweicloudsdkcore.auth.credentials import BasicCredentials
from huaweicloudsdkcore.exceptions import exceptions
from huaweicloudsdkmoderation.v2.region.moderation_region import ModerationRegion
from huaweicloudsdkmoderation.v2 import 
ModerationClient,RunImageBatchModerationRequest,ImageBatchModerationReq

if __name__ == "__main__":
       //Enter your AK/SK.
    ak = "<YOUR AK>"
    sk = "<YOUR SK>"

    credentials = BasicCredentials(ak, sk) 

    client = ModerationClient.new_builder() \
        .with_credentials(credentials) \
        .with_region(ModerationRegion.value_of("xxx")) \   //Replace xxx with the region where the 
service is located.
        .build()

    try:
        request = RunImageBatchModerationRequest()
        listImageBatchModerationReqCategoriesbody = [
            "porn",
        ]
        listImageBatchModerationReqUrlsbody = [
            "https://XXX.jpg"   //Replace it with an image URL that can be accessed from the Internet.
        ]
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        request.body = ImageBatchModerationReq(
            threshold=0,
            categories=listImageBatchModerationReqCategoriesbody,
            urls=listImageBatchModerationReqUrlsbody
        )
        response = client.run_image_batch_moderation(request)
        print(response.status_code)
        print(response)
    except exceptions.ClientRequestException as e:
        print(e.status_code)
        print(e.request_id)
        print(e.error_code)
        print(e.error_msg)

2. If 200 is displayed on the console, the code is successfully executed. The batch
Image Moderation result is displayed on the console.
200
{'result': [{'category_suggestions': {
                                      
                                      'porn': 'pass',
                                      },
             'detail': {
                        'porn': [{'confidence': 0.9883, 'label': 'normal'},
                                 {'confidence': 0.0039, 'label': 'porn'},
                                 {'confidence': 0.0078, 'label': 'sexy'}],
             'suggestion': 'pass',
             'url': 'https://sdk-obs-source-save.obs.cn-north-4.myhuaweicloud.com/terrorism.jpg'}]}

Process finished with exit code 0

6.3.2.3 Image Moderation (Asynchronous Batch) (V2)

6.3.2.3.1 Submitting a Task

1. This section describes how to use the Image Moderation SDK by AK/SK
authentication.
Replace the AK/SK in the sample code with the actual AK/SK. You can set urls
in TaskSumbitReq to configure the URLs of the images to be reviewed, and
then execute the code.
# coding: utf-8

from huaweicloudsdkcore.auth.credentials import BasicCredentials
from huaweicloudsdkcore.exceptions import exceptions
from huaweicloudsdkmoderation.v2.region.moderation_region import ModerationRegion
from huaweicloudsdkmoderation.v2 import *
from huaweicloudsdkmoderation.v2 import ModerationClient,RunTaskSumbitRequest,TaskSumbitReq

if __name__ == "__main__":
       //Enter your AK/SK.
    ak = "<YOUR AK>"
    sk = "<YOUR SK>"

    credentials = BasicCredentials(ak, sk) 

    client = ModerationClient.new_builder() \
        .with_credentials(credentials) \
        .with_region(ModerationRegion.value_of("xxx")) \    //Replace xxx with the region where the 
service is located.
        .build()

    try:
        request = RunTaskSumbitRequest()
        listTaskSumbitReqCategoriesbody = [
            "porn",
        ]
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        listTaskSumbitReqUrlsbody = [
            "https://XXX.jpg"   //Replace it with an image URL that can be accessed from the Internet.
        ]
        request.body = TaskSumbitReq(
            categories=listTaskSumbitReqCategoriesbody,
            urls=listTaskSumbitReqUrlsbody
        )
        response = client.run_task_sumbit(request)
        print(response.status_code)
        print(response)
    except exceptions.ClientRequestException as e:
        print(e.status_code)
        print(e.request_id)
        print(e.error_code)
        print(e.error_msg)

2. If 200 is displayed on the console, the code is successfully executed. The result
of submitting the Image Moderation (Asynchronous Batch) task is displayed
on the console.
200
{'result': {'job_id': 'xxx'}}

Process finished with exit code 0

6.3.2.3.2 Querying a Task
1. This section describes how to use the Image Moderation (Asynchronous

Batch) SDK for querying a task by AK/SK authentication.
Replace the AK/SK in the sample code with the actual AK/SK. Set job_id in
RunCheckResultRequest to configure the ID of the moderation task, and
then execute the code.
# coding: utf-8

from huaweicloudsdkcore.auth.credentials import BasicCredentials
from huaweicloudsdkcore.exceptions import exceptions
from huaweicloudsdkmoderation.v2.region.moderation_region import ModerationRegion
from huaweicloudsdkmoderation.v2 import *
from huaweicloudsdkmoderation.v2 import ModerationClient,RunCheckResultRequest

if __name__ == "__main__":
       //Enter your AK/SK.
    ak = "<YOUR AK>"
    sk = "<YOUR SK>"

    credentials = BasicCredentials(ak, sk) 

    client = ModerationClient.new_builder() \
        .with_credentials(credentials) \
        .with_region(ModerationRegion.value_of("xxx")) \   //Replace xxx with the region where the 
service is located.
        .build()

    try:
        request = RunCheckResultRequest()
        request.job_id = "xxx"  //Enter your job ID.
        response = client.run_check_result(request)
        print(response.status_code)
        print(response)
    except exceptions.ClientRequestException as e:
        print(e.status_code)
        print(e.request_id)
        print(e.error_code)
        print(e.error_msg)

2. If 200 is displayed on the console, the code is successfully executed. The result
of querying the Image Moderation (Asynchronous Batch) task is displayed on
the console.
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200
{'result': {'create_time': '2021-08-04T08:30:41Z',
            'items': [{'category_suggestions': {
                                                'porn': 'pass',
                                                },
                       'detail': {
 
                                  'porn': [{'confidence': 0.9883,
                                            'label': 'normal'},
                                           {'confidence': 0.0039,
                                            'label': 'porn'},
                                           {'confidence': 0.0078,
                                            'label': 'sexy'}],
                       'suggestion': 'pass',
                       'url': 'https://sdk-obs-source-save.obs.cn-north-4.myhuaweicloud.com/terrorism.jpg'}],
            'job_id': 'xxx',
            'status': 'finish',
            'update_time': '2021-08-04T08:30:41Z'}}

Process finished with exit code 0

6.3.3 Moderation (Video)

6.3.3.1 Creating a Video Moderation Job
1. This section describes how to create a video moderation job using the video

moderation SDK and AK/SK.
Replace the AK/SK in the sample code with the actual AK/SK. You can use the
withUrls method of the RunCreateVideoModerationJobRequest class to
configure the URLs of the videos to be reviewed, and then execute the code.

# coding: utf-8
 
from huaweicloudsdkcore.auth.credentials import BasicCredentials
from huaweicloudsdkmoderation.v3.region.moderation_region import ModerationRegion
from huaweicloudsdkcore.exceptions import exceptions
from huaweicloudsdkmoderation.v3 import *
 
if __name__ == "__main__":
       //Enter your AK/SK.
    ak = "<YOUR AK>"
    sk = "<YOUR SK>"
 
    credentials = BasicCredentials(ak, sk) \
 
    client = ModerationClient.new_builder() \
        .with_credentials(credentials) \
        .with_region(ModerationRegion.value_of("xxx")) \    //Replace xxx with the region where the 
service is located.
        .build()
 
    try:
        request = RunCreateVideoModerationJobRequest()
        listAudioCategoriesbody = [
            "porn"
        ]
        listImageCategoriesbody = [
            "porn"
        ]
        databody = VideoCreateRequestData(
            url="http://xxx.xx.xxxx",
            frame_interval=5.5
        )
        request.body = VideoCreateRequest(
            callback="http://xxx.xx.xxxx",
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            audio_categories=listAudioCategoriesbody,
            image_categories=listImageCategoriesbody,
            event_type="default",
            data=databody
        )
        response = client.run_create_video_moderation_job(request)
        print(response)
    except exceptions.ClientRequestException as e:
        print(e.status_code)
        print(e.request_id)
        print(e.error_code)
        print(e.error_msg)

2. The console returns the creation result of the video moderation job.
{"request_id": "dbbcb75d1a174bfa899a38be38fdd107", "job_id": "xxx"}

6.3.3.2 Querying a Video Moderation Job
1. This section describes how to query a video moderation job using the video

moderation SDK and AK/SK.
Replace the AK/SK in the sample code with the actual AK/SK. Use the
withJobId method of the RunQueryVideoModerationJobRequest class to
configure the ID of the moderation task, and then execute the code.

# coding: utf-8
 
from huaweicloudsdkcore.auth.credentials import BasicCredentials
from huaweicloudsdkmoderation.v3.region.moderation_region import ModerationRegion
from huaweicloudsdkcore.exceptions import exceptions
from huaweicloudsdkmoderation.v3 import *
 
if __name__ == "__main__":
       //Enter your AK/SK.
    ak = "<YOUR AK>"
    sk = "<YOUR SK>"
 
    credentials = BasicCredentials(ak, sk) \
 
    client = ModerationClient.new_builder() \
        .with_credentials(credentials) \
        .with_region(ModerationRegion.value_of("xxx")) \    //Replace xxx with the region where the 
service is located.
        .build()
 
    try:
        request = RunQueryVideoModerationJobRequest()
        request.job_id = "xxx"   //Enter your job ID.
        response = client.run_query_video_moderation_job(request)
        print(response)
    except exceptions.ClientRequestException as e:
        print(e.status_code)
        print(e.request_id)
        print(e.error_code)
        print(e.error_msg)

2. The console returns the query result of the video moderation job.
{"request_id":"xxxx","job_id":"xxx","status":"succeeded","request_params":{"data":
{"url":"xxxx","frame_interval":5},"event_type":"default","image_categories":
["porn","terrorism","image_text"],"audio_categories":
["porn","ad","moan","abuse"],"callback":"xxx"},"create_time":"2022-07-30T08:57:11.011Z","update_tim
e":"2022-07-30T08:57:14.014Z","result":{"suggestion":"block","image_detail":
[{"suggestion":"block","category":"porn","ocr_text":"123","time":0,"detail":[{"confidence":
0.676015138626099,"category":"porn","suggestion":"block","label":"pornography"},{"confidence":
0.666015138626099,"category":"porn","suggestion":"review","label":"sexy_female"},{"confidence":
0.666015138626099,"category":"xxx","suggestion":"block","label":"leader"},{"confidence":
0.691423773765564,"category":"xxx","suggestion":"block","face_location":{"top_left_x":12,"top_left_y":
13,"bottom_right_x":200,"bottom_right_y":240},"label":"leader"},{"confidence":
0.691423773765564,"category":"porn","suggestion":"block","face_location":{"top_left_x":

Content Moderation
SDK Reference 6 Using the Python SDK

Issue 01 (2023-08-22) Copyright © Huawei Technologies Co., Ltd. 25



12,"top_left_y":13,"bottom_right_x":100,"bottom_right_y":2000},"label":"leader"},{"confidence":
0.891423773765564,"category":"image_text","suggestion":"block","label":"qr_code"},{"confidence":
0.891423773765564,"category":"image_text","suggestion":"block","label":"qr_code","qr_content":"xxxxx
xxxx","qr_location":{"top_left_x":12,"top_left_y":13,"bottom_right_x":100,"bottom_right_y":2000}},
{"confidence":
0.891423773765564,"category":"image_text","suggestion":"block","label":"porn","segments":
[{"segment":"xxx"},{"segment":"xx"}]}]}],"audio_detail":
[{"suggestion":"block","label":"porn","audio_text":"xxxxx","end_time":10,"start_time":0,"detail":
[{"confidence":0.999117187582349,"label":"porn","suggestion":"block","segments":
[{"segment":"xxx"}]},{"confidence":0.885117187582349,"label":"porn","suggestion":"block"}]}]}}
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7 Using the .NET SDK

7.1 Preparing a .NET Development Environment
To use the .NET SDK of Content Moderation, you need to configure the .NET
development environment.

1. Download the latest Visual Studio from the Visual Studio official website.
2. Click the .exe file to start installation.
3. During the installation, select ASP.NET and web development on the

Workloads tab page.

7.2 Importing a .NET SDK into a .NET Environment
You can install the .Net SDK using commands or Visual Studio.

// Use .NET CLI to install the .Net SDK.
dotnet add package HuaweiCloud.SDK.Core 
dotnet add package HuaweiCloud.SDK.Moderation

// Use Package Manager to install the .Net SDK.
Install-Package HuaweiCloud.SDK.Core 
dotnet add package HuaweiCloud.SDK.Moderation

If you use Visual Studio, choose Tools > NuGet Package Manager > Manage
NuGet Packages for Solution..., and search for and install
HuaweiCloud.SDK.Core and HuaweiCloud.SDK.Moderation.

7.3 SDK Calling Example

7.3.1 Moderation (Text)

7.3.1.1 Text Moderation (V2)
1. This section describes how to use the Text Moderation SDK by AK/SK

authentication.
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Replace the AK/SK in the sample code with the actual AK/SK. Set text in
TextDetectionItemsReq in the code to configure the text to be detected, and
execute the code.

using System;
using System.Collections.Generic;
using HuaweiCloud.SDK.Core;
using HuaweiCloud.SDK.Core.Auth;
using HuaweiCloud.SDK.Moderation;
using HuaweiCloud.SDK.Moderation.V2;
using HuaweiCloud.SDK.Moderation.V2.Model;

namespace RunTextModerationSolution
{
    class Program
    {
        static void Main(string[] args)
        {
       //Enter your AK/SK.
            const string ak = "<YOUR AK>";
            const string sk = "<YOUR SK>";

            var config = HttpConfig.GetDefaultConfig();
            config.IgnoreSslVerification = true;
            var auth = new BasicCredentials(ak, sk);

            var client = ModerationClient.NewBuilder()
                    .WithCredential(auth)
                    .WithRegion(ModerationRegion.ValueOf("xxx")) //Replace xxx with the region where the 
service is located.
                    .WithHttpConfig(config)
                    .Build();

            var req = new RunTextModerationRequest
            {
            };
            List<TextDetectionItemsReq> listTextDetectionItemsReqItems = new 
List<TextDetectionItemsReq>();
            listTextDetectionItemsReqItems.Add(new TextDetectionItemsReq()
            {
                Text = "text",   //Enter the text to be detected.
                Type = "content"
            });
            List<String> listTextDetectionReqCategories = new List<String>();
            listTextDetectionReqCategories.Add("porn");
            listTextDetectionReqCategories.Add("abuse");
            listTextDetectionReqCategories.Add("contraband");
            listTextDetectionReqCategories.Add("flood");
            req.Body = new TextDetectionReq()
            {
                Items = listTextDetectionItemsReqItems,
                Categories = listTextDetectionReqCategories
            };

            try
            {
                var resp = client.RunTextModeration(req);
                var respStatusCode = resp.HttpStatusCode;
                Console.WriteLine(respStatusCode);
            Console.WriteLine(JsonConvert.DeserializeObject(resp.HttpBody));
            }
            catch (RequestTimeoutException requestTimeoutException)
            {
                Console.WriteLine(requestTimeoutException.ErrorMessage);
            }
            catch (ServiceResponseException clientRequestException)
            {
                Console.WriteLine(clientRequestException.HttpStatusCode);
                Console.WriteLine(clientRequestException.ErrorCode);
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                Console.WriteLine(clientRequestException.ErrorMsg);
            }
            catch (ConnectionException connectionException)
            {
                Console.WriteLine(connectionException.ErrorMessage);
            }
        }
    }
}

2. If 200 is displayed on the console, the code is successfully executed. The text
moderation result is displayed on the console.
200
{'result': {'detail': {'contraband': ['potassium arsenite'], 'porn': ['nude chat']},
            'suggestion': 'block'}}

7.3.2 Moderation (Image)

7.3.2.1 Image Moderation (V2)
1. This section describes how to use the Image Moderation SDK by AK/SK

authentication.
Replace the AK/SK in the sample code with the actual AK/SK. You can set
image or url (this section uses url as an example) in ImageDetectionReq to
configure information of the image to be reviewed. Then execute the code.

using System;
using System.Collections.Generic;
using HuaweiCloud.SDK.Core;
using HuaweiCloud.SDK.Core.Auth;
using HuaweiCloud.SDK.Moderation;
using HuaweiCloud.SDK.Moderation.V2;
using HuaweiCloud.SDK.Moderation.V2.Model;

namespace RunImageModerationSolution
{
    class Program
    {
        static void Main(string[] args)
        {
       //Enter your AK/SK.
            const string ak = "<YOUR AK>";
            const string sk = "<YOUR SK>";

            var config = HttpConfig.GetDefaultConfig();
            config.IgnoreSslVerification = true;
            var auth = new BasicCredentials(ak, sk);

            var client = ModerationClient.NewBuilder()
                    .WithCredential(auth)
                    .WithRegion(ModerationRegion.ValueOf("xxx")) //Replace xxx with the region where the 
service is located.
                    .WithHttpConfig(config)
                    .Build();

            var req = new RunImageModerationRequest
            {
            };
            List<ImageDetectionReq.CategoriesEnum> listImageDetectionReqCategories = new 
List<ImageDetectionReq.CategoriesEnum>();
            
listImageDetectionReqCategories.Add(ImageDetectionReq.CategoriesEnum.FromValue("porn"));
            req.Body = new ImageDetectionReq()
            {
                Threshold = 0,
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                Categories = listImageDetectionReqCategories,
                ModerationRule = "default",
                Url = "https://XXX.jpg"   //Replace it with an image URL that can be accessed from the 
Internet.
            };

            try
            {
                var resp = client.RunImageModeration(req);
                var respStatusCode = resp.HttpStatusCode;
                Console.WriteLine(respStatusCode);
                Console.WriteLine(JsonConvert.DeserializeObject(resp.HttpBody));
            }
            catch (RequestTimeoutException requestTimeoutException)
            {
                Console.WriteLine(requestTimeoutException.ErrorMessage);
            }
            catch (ServiceResponseException clientRequestException)
            {
                Console.WriteLine(clientRequestException.HttpStatusCode);
                Console.WriteLine(clientRequestException.ErrorCode);
                Console.WriteLine(clientRequestException.ErrorMsg);
            }
            catch (ConnectionException connectionException)
            {
                Console.WriteLine(connectionException.ErrorMessage);
            }
        }
    }
}

2. If 200 is displayed on the console, the code is successfully executed. The
image moderation result is displayed on the console.
200
{'result': {'category_suggestions': {
                                     'porn': 'pass',
                                     },
            'detail': {'ad': [{'confidence': 0.0, 'label': 'ad'},
                              {'confidence': 1.0, 'label': 'normal'}],
                       'porn': [{'confidence': 0.9883, 'label': 'normal'},
                                {'confidence': 0.0039, 'label': 'porn'},
                                {'confidence': 0.0078, 'label': 'sexy'}],
            'suggestion': 'pass'}}

7.3.2.2 Image Moderation (Batch) (V2)
1. This section describes how to use the Image Moderation SDK by AK/SK

authentication.
Replace the AK/SK in the sample code with the actual AK/SK. You can set Urls
in ImageBatchModerationReq to configure the URLs of the images to be
reviewed, and then execute the code.

using System;
using System.Collections.Generic;
using HuaweiCloud.SDK.Core;
using HuaweiCloud.SDK.Core.Auth;
using HuaweiCloud.SDK.Moderation;
using HuaweiCloud.SDK.Moderation.V2;
using HuaweiCloud.SDK.Moderation.V2.Model;

namespace RunImageBatchModerationSolution
{
    class Program
    {
        static void Main(string[] args)
        {
       //Enter your AK/SK.
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            const string ak = "<YOUR AK>";
            const string sk = "<YOUR SK>";

            var config = HttpConfig.GetDefaultConfig();
            config.IgnoreSslVerification = true;
            var auth = new BasicCredentials(ak, sk);

            var client = ModerationClient.NewBuilder()
                    .WithCredential(auth)
                    .WithRegion(ModerationRegion.ValueOf("xxx"))  //Replace xxx with the region where 
the service is located.
                    .WithHttpConfig(config)
                    .Build();

            var req = new RunImageBatchModerationRequest
            {
            };
            List<ImageBatchModerationReq.CategoriesEnum> listImageBatchModerationReqCategories = 
new List<ImageBatchModerationReq.CategoriesEnum>();
            
listImageBatchModerationReqCategories.Add(ImageBatchModerationReq.CategoriesEnum.FromValue(
"porn"));
            List<String> listImageBatchModerationReqUrls = new List<String>();
            listImageBatchModerationReqUrls.Add("https://XXX.jpg");  //Replace it with an image URL 
that can be accessed from the Internet.
            req.Body = new ImageBatchModerationReq()
            {
                Threshold = 0,
                Categories = listImageBatchModerationReqCategories,
                Urls = listImageBatchModerationReqUrls
            };

            try
            {
                var resp = client.RunImageBatchModeration(req);
                var respStatusCode = resp.HttpStatusCode;
                Console.WriteLine(respStatusCode);
            Console.WriteLine(JsonConvert.DeserializeObject(resp.HttpBody));
            }
            catch (RequestTimeoutException requestTimeoutException)
            {
                Console.WriteLine(requestTimeoutException.ErrorMessage);
            }
            catch (ServiceResponseException clientRequestException)
            {
                Console.WriteLine(clientRequestException.HttpStatusCode);
                Console.WriteLine(clientRequestException.ErrorCode);
                Console.WriteLine(clientRequestException.ErrorMsg);
            }
            catch (ConnectionException connectionException)
            {
                Console.WriteLine(connectionException.ErrorMessage);
            }
        }
    }
}

2. If 200 is displayed on the console, the code is successfully executed. The batch
Image Moderation result is displayed on the console.
200
{'result': [{'category_suggestions': {
                                      'porn': 'pass',
                                      },
             'detail': {'ad': [{'confidence': 0.0, 'label': 'ad'},
                               {'confidence': 1.0, 'label': 'normal'}],
                        'porn': [{'confidence': 0.9883, 'label': 'normal'},
                                 {'confidence': 0.0039, 'label': 'porn'},
                                 {'confidence': 0.0078, 'label': 'sexy'}],
             'suggestion': 'pass',
             'url': 'https://sdk-obs-source-save.obs.cn-north-4.myhuaweicloud.com/terrorism.jpg'}]}
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7.3.2.3 Image Moderation (Asynchronous Batch) (V2)

7.3.2.3.1 Submitting a Task
1. This section describes how to use the Image Moderation SDK by AK/SK

authentication.
Replace the AK/SK in the sample code with the actual AK/SK. You can set Urls
in RunTaskSumbitRequest to configure the URLs of the images to be
reviewed, and then execute the code.
using System;
using System.Collections.Generic;
using HuaweiCloud.SDK.Core;
using HuaweiCloud.SDK.Core.Auth;
using HuaweiCloud.SDK.Moderation;
using HuaweiCloud.SDK.Moderation.V2;
using HuaweiCloud.SDK.Moderation.V2.Model;

namespace RunTaskSumbitSolution
{
    class Program
    {
        static void Main(string[] args)
        {
       //Enter your AK/SK.
            const string ak = "<YOUR AK>";
            const string sk = "<YOUR SK>";

            var config = HttpConfig.GetDefaultConfig();
            config.IgnoreSslVerification = true;
            var auth = new BasicCredentials(ak, sk);

            var client = ModerationClient.NewBuilder()
                    .WithCredential(auth)
                    .WithRegion(ModerationRegion.ValueOf("xxx"))  //Replace xxx with the region where 
the service is located.
                    .WithHttpConfig(config)
                    .Build();

            var req = new RunTaskSumbitRequest
            {
            };
            List<TaskSumbitReq.CategoriesEnum> listTaskSumbitReqCategories = new 
List<TaskSumbitReq.CategoriesEnum>();
            listTaskSumbitReqCategories.Add(TaskSumbitReq.CategoriesEnum.FromValue("porn"));
            List<String> listTaskSumbitReqUrls = new List<String>();
            listTaskSumbitReqUrls.Add("https://XXX.jpg");    //Replace it with an image URL that can be 
accessed from the Internet.
            req.Body = new TaskSumbitReq()
            {
                Categories = listTaskSumbitReqCategories,
                Urls = listTaskSumbitReqUrls
            };

            try
            {
                var resp = client.RunTaskSumbit(req);
                var respStatusCode = resp.HttpStatusCode;
                Console.WriteLine(respStatusCode);
                Console.WriteLine(JsonConvert.DeserializeObject(resp.HttpBody));
            }
            catch (RequestTimeoutException requestTimeoutException)
            {
                Console.WriteLine(requestTimeoutException.ErrorMessage);
            }
            catch (ServiceResponseException clientRequestException)
            {
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                Console.WriteLine(clientRequestException.HttpStatusCode);
                Console.WriteLine(clientRequestException.ErrorCode);
                Console.WriteLine(clientRequestException.ErrorMsg);
            }
            catch (ConnectionException connectionException)
            {
                Console.WriteLine(connectionException.ErrorMessage);
            }
        }
    }
}

2. If 200 is displayed on the console, the code is successfully executed. The result
of submitting the Image Moderation (Asynchronous Batch) task is displayed
on the console.
200
{'result': {'job_id': 'xxx'}}

7.3.2.3.2 Querying a Task

1. This section describes how to use the Image Moderation (Asynchronous
Batch) SDK for querying a task by AK/SK authentication.
Replace the AK/SK in the sample code with the actual AK/SK. Set JobId in
RunCheckResultRequest to configure the ID of the moderation task, and
then execute the code.

using System;
using System.Collections.Generic;
using HuaweiCloud.SDK.Core;
using HuaweiCloud.SDK.Core.Auth;
using HuaweiCloud.SDK.Moderation;
using HuaweiCloud.SDK.Moderation.V2;
using HuaweiCloud.SDK.Moderation.V2.Model;

namespace RunCheckResultSolution
{
    class Program
    {
        static void Main(string[] args)
        {
       //Enter your AK/SK.
            const string ak = "<YOUR AK>";
            const string sk = "<YOUR SK>";

            var config = HttpConfig.GetDefaultConfig();
            config.IgnoreSslVerification = true;
            var auth = new BasicCredentials(ak, sk);

            var client = ModerationClient.NewBuilder()
                    .WithCredential(auth)
                    .WithRegion(ModerationRegion.ValueOf("xxx"))  //Replace xxx with the region where 
the service is located.
                    .WithHttpConfig(config)
                    .Build();

            var req = new RunCheckResultRequest
            {
                JobId = "2991572e-f503-11eb-a32d-88bd0dde8061"
            };

            try
            {
                var resp = client.RunCheckResult(req);
                var respStatusCode = resp.HttpStatusCode;
                Console.WriteLine(respStatusCode);
                Console.WriteLine(JsonConvert.DeserializeObject(resp.HttpBody));
            }
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            catch (RequestTimeoutException requestTimeoutException)
            {
                Console.WriteLine(requestTimeoutException.ErrorMessage);
            }
            catch (ServiceResponseException clientRequestException)
            {
                Console.WriteLine(clientRequestException.HttpStatusCode);
                Console.WriteLine(clientRequestException.ErrorCode);
                Console.WriteLine(clientRequestException.ErrorMsg);
            }
            catch (ConnectionException connectionException)
            {
                Console.WriteLine(connectionException.ErrorMessage);
            }
        }
    }
}

1. If 200 is displayed on the console, the code is successfully executed. The result
of querying the Image Moderation (Asynchronous Batch) task is displayed on
the console.
200
{'result': {'create_time': '2021-08-04T08:30:41Z',
            'items': [{'category_suggestions': {
                                                'porn': 'pass',
                                               },
                       'detail': {'ad': None,
                                  'porn': [{'confidence': 0.9883,
                                            'label': 'normal'},
                                           {'confidence': 0.0039,
                                            'label': 'porn'},
                                           {'confidence': 0.0078,
                                            'label': 'sexy'}],
                       'suggestion': 'pass',
                       'url': 'https://sdk-obs-source-save.obs.cn-north-4.myhuaweicloud.com/terrorism.jpg'}],
            'job_id': 'xxx',
            'status': 'finish',
            'update_time': '2021-08-04T08:30:41Z'}}

7.3.3 Moderation (Video)

7.3.3.1 Creating a Video Moderation Job
1. This section describes how to create a video moderation job using the video

moderation SDK and AK/SK.
Replace the AK/SK in the sample code with the actual AK/SK. You can use the
withUrls method of the RunCreateVideoModerationJobRequest class to
configure the URLs of the videos to be reviewed, and then execute the code.

using System;
using System.Collections.Generic;
using HuaweiCloud.SDK.Core;
using HuaweiCloud.SDK.Core.Auth;
using HuaweiCloud.SDK.Moderation;
using HuaweiCloud.SDK.Moderation.V3;
using HuaweiCloud.SDK.Moderation.V3.Model;
 
namespace RunCreateVideoModerationJobSolution
{
    class Program
    {
        static void Main(string[] args)
        {
       //Enter your AK/SK.
            const string ak = "<YOUR AK>";
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            const string sk = "<YOUR SK>";
 
            var config = HttpConfig.GetDefaultConfig();
            config.IgnoreSslVerification = true;
            var auth = new BasicCredentials(ak, sk);
 
            var client = ModerationClient.NewBuilder()
                    .WithCredential(auth)
                    .WithRegion(ModerationRegion.ValueOf("xxx"))  //Replace xxx with the region where 
the service is located.
                    .WithHttpConfig(config)
                    .Build();
 
            var req = new RunCreateVideoModerationJobRequest
            {
            };
            List<VideoCreateRequest.AudioCategoriesEnum> listAudioCategoriesbody = new 
List<VideoCreateRequest.AudioCategoriesEnum>();
            listAudioCategoriesbody.Add(VideoCreateRequest.AudioCategoriesEnum.FromValue("porn"));
            List<VideoCreateRequest.ImageCategoriesEnum> listImageCategoriesbody = new 
List<VideoCreateRequest.ImageCategoriesEnum>();
            listImageCategoriesbody.Add(VideoCreateRequest.ImageCategoriesEnum.FromValue("porn"));
            VideoCreateRequestData databody = new VideoCreateRequestData()
            {
                Url = "http://xxx.xx.xxxx",
                FrameInterval = 5.5
            };
            req.Body = new VideoCreateRequest()
            {
                Callback = "http://xxx.xx.xxxx",
                AudioCategories = listAudioCategoriesbody,
                ImageCategories = listImageCategoriesbody,
                EventType = VideoCreateRequest.EventTypeEnum.FromValue("default"),
                Data = databody
            };
 
            try
            {
                var resp = client.RunCreateVideoModerationJob(req);
                var respStatusCode = resp.HttpStatusCode;
                Console.WriteLine(respStatusCode);
            }
            catch (RequestTimeoutException requestTimeoutException)
            {
                Console.WriteLine(requestTimeoutException.ErrorMessage);
            }
            catch (ServiceResponseException clientRequestException)
            {
                Console.WriteLine(clientRequestException.HttpStatusCode);
                Console.WriteLine(clientRequestException.ErrorCode);
                Console.WriteLine(clientRequestException.ErrorMsg);
            }
            catch (ConnectionException connectionException)
            {
                Console.WriteLine(connectionException.ErrorMessage);
            }
        }
    }
}

2. The console returns the creation result of the video moderation job.
200
 {
    "request_id":"dbbcb75d1a174bfa899a38be38fdd107",
    "job_id":"xxx"
}
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7.3.3.2 Querying a Video Moderation Job
1. This section describes how to query a video moderation job using the video

moderation SDK and AK/SK.
Replace the AK/SK in the sample code with the actual AK/SK. Use the
withJobId method of the RunQueryVideoModerationJobRequest class to
configure the ID of the moderation task, and then execute the code.

using System;
using System.Collections.Generic;
using HuaweiCloud.SDK.Core;
using HuaweiCloud.SDK.Core.Auth;
using HuaweiCloud.SDK.Moderation;
using HuaweiCloud.SDK.Moderation.V3;
using HuaweiCloud.SDK.Moderation.V3.Model;

namespace RunQueryVideoModerationJobSolution
{
    class Program
    {
        static void Main(string[] args)
        {
        //Enter your AK/SK.
            const string ak = "<YOUR AK>";
            const string sk = "<YOUR SK>";

            var config = HttpConfig.GetDefaultConfig();
            config.IgnoreSslVerification = true;
            var auth = new BasicCredentials(ak, sk);

            var client = ModerationClient.NewBuilder()
                    .WithCredential(auth)
                    .WithRegion(ModerationRegion.ValueOf("xxx"))  //Replace xxx with the region where 
the service is located.
                    .WithHttpConfig(config)
                    .Build();

            var req = new RunQueryVideoModerationJobRequest
            {
                JobId = "xxxx"    //Enter your job ID.
            };

            try
            {
                var resp = client.RunQueryVideoModerationJob(req);
                var respStatusCode = resp.HttpStatusCode;
                Console.WriteLine(respStatusCode);
Console.WriteLine(JsonConvert.DeserializeObject(resp.HttpBody));
            }
            catch (RequestTimeoutException requestTimeoutException)
            {
                Console.WriteLine(requestTimeoutException.ErrorMessage);
            }
            catch (ServiceResponseException clientRequestException)
            {
                Console.WriteLine(clientRequestException.HttpStatusCode);
                Console.WriteLine(clientRequestException.ErrorCode);
                Console.WriteLine(clientRequestException.ErrorMsg);
            }
            catch (ConnectionException connectionException)
            {
                Console.WriteLine(connectionException.ErrorMessage);
            }
        }
    }
}

2. The console returns the query result of the video moderation job.
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200
{
    "request_id":"xxxx",
    "job_id":"xxx",
    "status":"succeeded",
    "request_params":{
        "data":{
            "url":"xxxx",
            "frame_interval":5
        },
        "event_type":"default",
        "image_categories":[
            "porn",
            "terrorism",
            "image_text"
        ],
        "audio_categories":[
            "porn",
            "ad",
            "moan",
            "abuse"
        ],
        "callback":"xxx"
    },
    "create_time":"2022-07-30T08:57:11.011Z",
    "update_time":"2022-07-30T08:57:14.014Z",
    "result":{
        "suggestion":"block",
        "image_detail":[
            {
                "suggestion":"block",
                "category":"porn",
                "ocr_text":"123",
                "time":0,
                "detail":[
                    {
                        "confidence":0.676015138626099,
                        "category":"porn",
                        "suggestion":"block",
                        "label":"pornography"
                    },
                    {
                        "confidence":0.666015138626099,
                        "category":"porn",
                        "suggestion":"review",
                        "label":"sexy_female"
                    },
                    {
                        "confidence":0.666015138626099,
                        "category":"xxx",
                        "suggestion":"block",
                        "label":"leader"
                    },
                    {
                        "confidence":0.691423773765564,
                        "category":"xxx",
                        "suggestion":"block",
                        "face_location":{
                            "top_left_x":12,
                            "top_left_y":13,
                            "bottom_right_x":200,
                            "bottom_right_y":240
                        },
                        "label":"leader"
                    },
                    {
                        "confidence":0.691423773765564,
                        "category":"porn",
                        "suggestion":"block",

Content Moderation
SDK Reference 7 Using the .NET SDK

Issue 01 (2023-08-22) Copyright © Huawei Technologies Co., Ltd. 37



                        "face_location":{
                            "top_left_x":12,
                            "top_left_y":13,
                            "bottom_right_x":100,
                            "bottom_right_y":2000
                        },
                        "label":"leader"
                    },
                    {
                        "confidence":0.891423773765564,
                        "category":"image_text",
                        "suggestion":"block",
                        "label":"qr_code"
                    },
                    {
                        "confidence":0.891423773765564,
                        "category":"image_text",
                        "suggestion":"block",
                        "label":"qr_code",
                        "qr_content":"xxxxxxxxx",
                        "qr_location":{
                            "top_left_x":12,
                            "top_left_y":13,
                            "bottom_right_x":100,
                            "bottom_right_y":2000
                        }
                    },
                    {
                        "confidence":0.891423773765564,
                        "category":"image_text",
                        "suggestion":"block",
                        "label":"porn",
                        "segments":[
                            {
                                "segment":"xxx"
                            },
                            {
                                "segment":"xx"
                            }
                        ]
                    }
                ]
            }
        ],
        "audio_detail":[
            {
                "suggestion":"block",
                "label":"porn",
                "audio_text":"xxxxx",
                "end_time":10,
                "start_time":0,
                "detail":[
                    {
                        "confidence":0.999117187582349,
                        "label":"porn",
                        "suggestion":"block",
                        "segments":[
                            {
                                "segment":"xxx"
                            }
                        ]
                    },
                    {
                        "confidence":0.885117187582349,
                        "label":"porn",
                        "suggestion":"block"
                    }
                ]
            }
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        ]
    }
}
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8 Using the Go SDK

8.1 Preparing a Go Development Environment
To use the Go SDK of Image Recognition, you need to configure the Go
development environment. If the Go development environment has been installed,
skip this section.

1. Download Go 1.14 or a later version from the Go official website.

2. Install the downloaded Go in a specified path, for example, D:\develop\go.

3. Right-click Computer, choose Properties > Advanced System Settings >
Environment Variables, and perform the following operations:

a. Create system variable GOROOT whose value is the Go installation path.
Add environment variable GOPATH, which indicates the directory where
the Go project is located.

b. Append ;%GOROOT%\bin (path of the Go compiler) to the PATH
variable.

c. Append ;%GOROOT%\lib (path of the Go compiler) to the CLASSPATH
variable.

4. Download Visual Studio Code from its official website and install it.

5. Install the Go and Go Critic plug-ins.

8.2 Obtaining and Installing the Go SDK
1. Run the following command:

go get -u github.com/huaweicloud/huaweicloud-sdk-go-v3

8.3 SDK Calling Example

8.3.1 Moderation (Text)
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8.3.1.1 Text Moderation (V2)
1. This section describes how to use the Text Moderation SDK by AK/SK

authentication.
Replace the AK/SK in the sample code with the actual AK/SK. Set Text in
TextDetectionItemsReq in the code to configure the text to be detected, and
execute the code.
package main

import (
    "fmt"
    "github.com/huaweicloud/huaweicloud-sdk-go-v3/core/auth/basic"
    moderation "github.com/huaweicloud/huaweicloud-sdk-go-v3/services/moderation/v2"
    "github.com/huaweicloud/huaweicloud-sdk-go-v3/services/moderation/v2/model"
    region "github.com/huaweicloud/huaweicloud-sdk-go-v3/services/moderation/v2/region"
)

func main() {
       //Enter your AK/SK.
    ak := "<YOUR AK>"
    sk := "<YOUR SK>"

    auth := basic.NewCredentialsBuilder().
        WithAk(ak).
        WithSk(sk).
        Build()

    client := moderation.NewModerationClient(
        moderation.ModerationClientBuilder().
            WithRegion(region.ValueOf("cn-north-4")).
            WithCredential(auth).
            Build())

    request := &model.RunTextModerationRequest{}
    typeItemsTextDetectionItemsReq:= "content"
    var listItemsbody = []model.TextDetectionItemsReq{
        {
            Text: "text",     //Enter the text to be detected.
            Type: &typeItemsTextDetectionItemsReq,
        },
    }
    var listCategoriesbody = []string{
        "porn",
        "abuse",
        "contraband",
        "flood",
    }
    request.Body = &model.TextDetectionReq{
        Items: listItemsbody,
        Categories: &listCategoriesbody,
    }
    response, err := client.RunTextModeration(request)
    if err == nil {
        fmt.Printf("%+v\n", response)
    } else {
        fmt.Println(err)
    }}

2. If the moderation result is displayed on the console, the code is successfully
executed.
RunTextModerationResponse {"result":{"suggestion":"block","detail":{"contraband":["potassium 
arsenite"],"porn":["nude chat"]}}} 
Process exiting with code: 0 

8.3.2 Moderation (Image)
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8.3.2.1 Image Moderation (V2)
1. This section describes how to use the Image Moderation SDK by AK/SK

authentication.
Replace the AK/SK in the sample code with the actual AK/SK. You can use
either the image or url parameter (representing the URL or Base64 code of
the image) to configure the image information. This section uses url as an
example.
package main

import (
    "fmt"
    "github.com/huaweicloud/huaweicloud-sdk-go-v3/core/auth/basic"
    moderation "github.com/huaweicloud/huaweicloud-sdk-go-v3/services/moderation/v2"
    "github.com/huaweicloud/huaweicloud-sdk-go-v3/services/moderation/v2/model"
    region "github.com/huaweicloud/huaweicloud-sdk-go-v3/services/moderation/v2/region"
)

func main() {
       //Enter your AK/SK.
    ak := "<YOUR AK>"
    sk := "<YOUR SK>"

    auth := basic.NewCredentialsBuilder().
        WithAk(ak).
        WithSk(sk).
        Build()

    client := moderation.NewModerationClient(
        moderation.ModerationClientBuilder().
            WithRegion(region.ValueOf("cn-north-4")).
            WithCredential(auth).
            Build())

    request := &model.RunImageModerationRequest{}
    var listCategoriesbody = []model.ImageDetectionReqCategories{
        model.GetImageDetectionReqCategoriesEnum().PORN,
    }
    thresholdImageDetectionReq:= float32(0)
    moderationRuleImageDetectionReq:= "default"
    urlImageDetectionReq:= "https://XXX.jpg"  //Replace it with an image URL that can be accessed 
from the Internet.
    request.Body = &model.ImageDetectionReq{
        Threshold: &thresholdImageDetectionReq,
        Categories: &listCategoriesbody,
        ModerationRule: &moderationRuleImageDetectionReq,
        Url: &urlImageDetectionReq,
    }
    response, err := client.RunImageModeration(request)
    if err == nil {
        fmt.Printf("%+v\n", response)
    } else {
        fmt.Println(err)
    }}

2. If the moderation result is displayed on the console, the code is successfully
executed.
RunImageModerationResponse {"result":{"detail":{"porn":[{"confidence":0.9883,"label":"normal"},
{"confidence":0.0039,"label":"porn"},{"confidence":
0.0078,"label":"sexy"}]},"suggestion":"pass","category_suggestions":{"porn":"pass",}}}
Process exiting with code: 0 

8.3.2.2 Image Moderation (Batch) (V2)
1. This section describes how to use the Image Moderation (Batch) SDK by

AK/SK authentication.
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Replace the AK/SK in the sample code with the actual AK/SK. You can set Urls
in ImageBatchModerationReq to configure the URLs of the images to be
reviewed, and then execute the code.
package main

import (
    "fmt"
    "github.com/huaweicloud/huaweicloud-sdk-go-v3/core/auth/basic"
    moderation "github.com/huaweicloud/huaweicloud-sdk-go-v3/services/moderation/v2"
    "github.com/huaweicloud/huaweicloud-sdk-go-v3/services/moderation/v2/model"
    region "github.com/huaweicloud/huaweicloud-sdk-go-v3/services/moderation/v2/region"
)

func main() {
       //Enter your AK/SK.
    ak := "<YOUR AK>"
    sk := "<YOUR SK>"

    auth := basic.NewCredentialsBuilder().
        WithAk(ak).
        WithSk(sk).
        Build()

    client := moderation.NewModerationClient(
        moderation.ModerationClientBuilder().
            WithRegion(region.ValueOf("cn-north-4")).
            WithCredential(auth).
            Build())

    request := &model.RunImageBatchModerationRequest{}
    var listCategoriesbody = []model.ImageBatchModerationReqCategories{
        model.GetImageBatchModerationReqCategoriesEnum().PORN,
    }
    var listUrlsbody = []string{
        "https://XXX.jpg",  //Replace it with an image URL that can be accessed from the Internet.
    }
    thresholdImageBatchModerationReq:= float64(0)
    request.Body = &model.ImageBatchModerationReq{
        Threshold: &thresholdImageBatchModerationReq,
        Categories: &listCategoriesbody,
        Urls: listUrlsbody,
    }
    response, err := client.RunImageBatchModeration(request)
    if err == nil {
        fmt.Printf("%+v\n", response)
    } else {
        fmt.Println(err)
    }}

2. If the moderation result is displayed on the console, the code is successfully
executed.
RunImageBatchModerationResponse {"result":[{"url":"https://sdk-obs-source-save.obs.cn-
north-4.myhuaweicloud.com/terrorism.jpg","suggestion":"pass","detail":{"porn":[{"confidence":
0.9883,"label":"normal"},{"confidence":0.0039,"label":"porn"},{"confidence":
0.0078,"label":"sexy"}]},"category_suggestions":{
,"porn":"pass"}}]}
Process exiting with code: 0

8.3.2.3 Image Moderation (Asynchronous Batch) (V2)

8.3.2.3.1 Submitting a Task

1. This section describes how to use the Image Moderation (Asynchronous
Batch) SDK for submitting a task by AK/SK authentication.
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Replace the AK/SK in the sample code with the actual AK/SK. You can set Urls
in TaskSumbitReq to configure the URLs of the images to be reviewed, and
then execute the code.
package main

import (
    "fmt"
    "github.com/huaweicloud/huaweicloud-sdk-go-v3/core/auth/basic"
    moderation "github.com/huaweicloud/huaweicloud-sdk-go-v3/services/moderation/v2"
    "github.com/huaweicloud/huaweicloud-sdk-go-v3/services/moderation/v2/model"
    region "github.com/huaweicloud/huaweicloud-sdk-go-v3/services/moderation/v2/region"
)

func main() {
       //Enter your AK/SK.
    ak := "<YOUR AK>"
    sk := "<YOUR SK>"

    auth := basic.NewCredentialsBuilder().
        WithAk(ak).
        WithSk(sk).
        Build()

    client := moderation.NewModerationClient(
        moderation.ModerationClientBuilder().
            WithRegion(region.ValueOf("cn-north-4")).
            WithCredential(auth).
            Build())

    request := &model.RunTaskSumbitRequest{}
    var listCategoriesbody = []model.TaskSumbitReqCategories{
        model.GetTaskSumbitReqCategoriesEnum().PORN,
    }
    var listUrlsbody = []string{
        "https://XXX.jpg",   //Replace it with an image URL that can be accessed from the Internet.
    }
    request.Body = &model.TaskSumbitReq{
        Categories: &listCategoriesbody,
        Urls: listUrlsbody,
    }
    response, err := client.RunTaskSumbit(request)
    if err == nil {
        fmt.Printf("%+v\n", response)
    } else {
        fmt.Println(err)
    }}

2. If the task submission result is displayed on the console, the code is
successfully executed.
RunTaskSumbitResponse {"result":{"job_id":"xxx"}}
Process exiting with code: 0

8.3.2.3.2 Querying a Task

1. This section describes how to use the Image Moderation (Asynchronous
Batch) SDK for querying a task by AK/SK authentication.
Replace the AK/SK in the sample code with the actual AK/SK. Use JobId of
RunCheckResultRequest to configure the ID of the moderation task, and
then execute the code.
package main

import (
    "fmt"
    "github.com/huaweicloud/huaweicloud-sdk-go-v3/core/auth/basic"
    moderation "github.com/huaweicloud/huaweicloud-sdk-go-v3/services/moderation/v2"
    "github.com/huaweicloud/huaweicloud-sdk-go-v3/services/moderation/v2/model"
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    region "github.com/huaweicloud/huaweicloud-sdk-go-v3/services/moderation/v2/region"
)

func main() {
       //Enter your AK/SK.
    ak := "<YOUR AK>"
    sk := "<YOUR SK>"

    auth := basic.NewCredentialsBuilder().
        WithAk(ak).
        WithSk(sk).
        Build()

    client := moderation.NewModerationClient(
        moderation.ModerationClientBuilder().
            WithRegion(region.ValueOf("cn-north-4")).
            WithCredential(auth).
            Build())

    request := &model.RunCheckResultRequest{}
    request.JobId = "70e952b5-5fa3-4d18-9ce4-75bba7226d7c"
    response, err := client.RunCheckResult(request)
    if err == nil {
        fmt.Printf("%+v\n", response)
    } else {
        fmt.Println(err)
    }
}

2. If the moderation result is displayed on the console, the code is successfully
executed.
RunCheckResultResponse {"result":
{"job_id":"xxx","status":"finish","create_time":"2021-08-05T03:44:37Z","update_time":"2021-08-05T03:4
4:37Z","items":[{"url":"https://sdk-obs-source-save.obs.cn-north-4.myhuaweicloud.com/
terrorism.jpg","suggestion":"pass","detail":{"porn":[{"confidence":0.9883,"label":"normal"},
{"confidence":0.0039,"label":"porn"},{"confidence":0.0078,"label":"sexy"}]},"category_suggestions":
{"porn":"pass",}}]}}
Process exiting with code: 0

8.3.3 Moderation (Video)

8.3.3.1 Creating a Video Moderation Job
1. This section describes how to create a video moderation job using the video

moderation SDK and AK/SK.
Replace the AK/SK in the sample code with the actual AK/SK. You can use the
withUrls method of the RunCreateVideoModerationJobRequest class to
configure the URLs of the videos to be reviewed, and then execute the code.
package main
 
import (
    "fmt"
    "github.com/huaweicloud/huaweicloud-sdk-go-v3/core/auth/basic"
    moderation "github.com/huaweicloud/huaweicloud-sdk-go-v3/services/moderation/v3"
    "github.com/huaweicloud/huaweicloud-sdk-go-v3/services/moderation/v3/model"
    region "github.com/huaweicloud/huaweicloud-sdk-go-v3/services/moderation/v3/region"
)
 
func main() {
       //Enter your AK/SK.
    ak := "<YOUR AK>"
    sk := "<YOUR SK>"
 
    auth := basic.NewCredentialsBuilder().
        WithAk(ak).
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        WithSk(sk).
        Build()
 
    client := moderation.NewModerationClient(
        moderation.ModerationClientBuilder().
            WithRegion(region.ValueOf("xxx")).   //Replace xxx with the region where the service is 
located.
            WithCredential(auth).
            Build())
 
    request := &model.RunCreateVideoModerationJobRequest{}
    var listAudioCategoriesbody = []model.VideoCreateRequestAudioCategories{
        model.GetVideoCreateRequestAudioCategoriesEnum().PORN,
    }
    var listImageCategoriesbody = []model.VideoCreateRequestImageCategories{
        model.GetVideoCreateRequestImageCategoriesEnum().PORN,
    }
    frameIntervalData:= float32(5.5)
    databody := &model.VideoCreateRequestData{
        Url: "http://xxx.xx.xxxx",
        FrameInterval: &frameIntervalData,
    }
    callbackVideoCreateRequest:= "http://xxx.xx.xxxx"
    request.Body = &model.VideoCreateRequest{
        Callback: &callbackVideoCreateRequest,
        AudioCategories: &listAudioCategoriesbody,
        ImageCategories: listImageCategoriesbody,
        EventType: model.GetVideoCreateRequestEventTypeEnum().DEFAULT,
        Data: databody,
    }
    response, err := client.RunCreateVideoModerationJob(request)
    if err == nil {
        fmt.Printf("%+v\n", response)
    } else {
        fmt.Println(err)
    }
}

2. The console returns the creation result of the video moderation job.
RunCreateVideoModerationJobResponse{"request_id":"dbbcb75d1a174bfa899a38be38fdd107", 
"job_id": "xxx"}

8.3.3.2 Querying a Video Moderation Job
1. This section describes how to query a video moderation job using the video

moderation SDK and AK/SK.
Replace the AK/SK in the sample code with the actual AK/SK. Use the
withJobId method of the RunQueryVideoModerationJobRequest class to
configure the ID of the moderation task, and then execute the code.
package main
 
import (
    "fmt"
    "github.com/huaweicloud/huaweicloud-sdk-go-v3/core/auth/basic"
    moderation "github.com/huaweicloud/huaweicloud-sdk-go-v3/services/moderation/v3"
    "github.com/huaweicloud/huaweicloud-sdk-go-v3/services/moderation/v3/model"
    region "github.com/huaweicloud/huaweicloud-sdk-go-v3/services/moderation/v3/region"
)
 
func main() {
     //Enter your job ID.
    ak := "<YOUR AK>"
    sk := "<YOUR SK>"
 
    auth := basic.NewCredentialsBuilder().
        WithAk(ak).
        WithSk(sk).
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        Build()
 
    client := moderation.NewModerationClient(
        moderation.ModerationClientBuilder().
            WithRegion(region.ValueOf("xxx")). //Replace xxx with the region where the service is located.
            WithCredential(auth).
            Build())
 
    request := &model.RunQueryVideoModerationJobRequest{}
    request.JobId = "xxxx"   //Enter your job ID.
    response, err := client.RunQueryVideoModerationJob(request)
    if err == nil {
        fmt.Printf("%+v\n", response)
    } else {
        fmt.Println(err)
    }
}

2. The console returns the query result of the video moderation job.
RunQueryVideoModerationJobResponse 
{"request_id":"xxxx","job_id":"xxx","status":"succeeded","request_params":{"data":
{"url":"xxxx","frame_interval":5},"event_type":"default","image_categories":
["porn","terrorism","image_text"],"audio_categories":
["porn","ad","moan","abuse"],"callback":"xxx"},"create_time":"2022-07-30T08:57:11.011Z","update_tim
e":"2022-07-30T08:57:14.014Z","result":{"suggestion":"block","image_detail":
[{"suggestion":"block","category":"porn","ocr_text":"123","time":0,"detail":[{"confidence":
0.676015138626099,"category":"porn","suggestion":"block","label":"pornography"},{"confidence":
0.666015138626099,"category":"porn","suggestion":"review","label":"sexy_female"},{"confidence":
0.666015138626099,"category":"xxx","suggestion":"block","label":"leader"},{"confidence":
0.691423773765564,"category":"xxx","suggestion":"block","face_location":{"top_left_x":12,"top_left_y":
13,"bottom_right_x":200,"bottom_right_y":240},"label":"leader"},{"confidence":
0.691423773765564,"category":"porn","suggestion":"block","face_location":{"top_left_x":
12,"top_left_y":13,"bottom_right_x":100,"bottom_right_y":2000},"label":"leader"},{"confidence":
0.891423773765564,"category":"image_text","suggestion":"block","label":"qr_code"},{"confidence":
0.891423773765564,"category":"image_text","suggestion":"block","label":"qr_code","qr_content":"xxxxx
xxxx","qr_location":{"top_left_x":12,"top_left_y":13,"bottom_right_x":100,"bottom_right_y":2000}},
{"confidence":
0.891423773765564,"category":"image_text","suggestion":"block","label":"porn","segments":
[{"segment":"xxx"},{"segment":"xx"}]}]}],"audio_detail":
[{"suggestion":"block","label":"porn","audio_text":"xxxxx","end_time":10,"start_time":0,"detail":
[{"confidence":0.999117187582349,"label":"porn","suggestion":"block","segments":
[{"segment":"xxx"}]},{"confidence":0.885117187582349,"label":"porn","suggestion":"block"}]}]}}
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